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Taming the Nightmare Document

Working with ‘Nightmare’ Documents

Documents edited over time by multiple individuals often result in:

e Incorrect numbering — causing problems with document navigation and cross-references

e Inconsistent formatting — document appears unprofessional and disorganised, reduces readability

e Errorsin the table of contents — text is incorrectly included/excluded

e Missing/incorrect cross references

Tight deadlines lead to users looking for a “quick fix” to document issues — often causing more problems in the long

run. Sometimes users sit within different departments, firms or organisations, each bringing in their own house styles

and ways of working. Issues within a document should always be explored and corrected properly.

Type numbers in a numbered list
Manually correct text formatting issues
Manually correct paragraph formatting

issues

Manually type cross references

Manually type table of contents

Identifying Issues

Check:

= The correct style is applied

= Multi-level list options

Check:

+ Thecorrect style is applied

+ Style font options

Check:

= Thecorrect style is applied

= Style paragraph options

Correct using Word’s cross-referencing tool

Check:
= Styles within document
» Table of contents options

Before you can resolve issues within a document, you need to be able to identify them. Many issues can be identified

by eye, such as obvious formatting issues and incorrect numbering.

conditions agreed by both parties.

1) RENT

month.

23 Early termination by mutual agreement may be made in writihng and subject to

2.4 The monthly Rent shall be £1,200, payable in advance on the first day of each calendar

Clicking on a cross-reference or number helps identify whether it is manually typed — those that have been entered

manually are not shaded.

A cross-reference that has been created using the Cross-Reference tool:

n and habitable condition; otherwise, cleaning
e Security Deposit (see clause 4.3)

A manually typed number:

Page 2 of 16



Taming the Nightmare Document

TOuT oo oo Il G ¥,

510 Notices sent via email sh
obtained.

5.9.1 Change of addres

Clicking on any number in the document that has not been manually typed will display shading over any numbers in
the document at the same level. In the example below, it is easy to identify 5.10 as manually typed number as it is not
shaded.

a8 Any notice required under this Agreement shall be in writing and delivered to the
addresses stated above.

5.10 Notices sent via email shall be considered valid only if confirmation of receipt is

obtained.
59.1 Change of address must be communicated within seven (7) days.
59.2 This agreement constitutes the entire understanding between the parties

and supersedes any prior agreements or representations.

593 Amendments to this Agreement must be made in writing and signed by both
parties.

5.10 This Agreement shall be governed by the laws of England.

5.10.1 Disputes shall be resolved in the courts of London, England.

Another method to identify issues in a document is to check the style applied to text. Click or select a word or
paragraph to display its style in the Styles Gallery or Styles Pane. An incorrect style can lead to issues with numbering
and formatting. There is more information on styles in the next section.

1. HEADIN( 1. HEADING A1 | 1) MAIN HEADI | +

es [

-
w
=
w
(=]
=
)
=
=
il

9 10 2L 01200 2130 21400

2.3 Early termination mutual agreement may be made in writing and su
conditions d by both parties.

¥ 1) RENT

2.4 The monthly Rent shall be £1,200, payable in advance on the first day of each
month.
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Taming the Nightmare Document

Styles

The style applied to text controls its font formatting, paragraph formatting and numbering (if the style is associated
with a multi level number style).

The Styles Gallery and Styles Pane
Styles can be checked, applied and modified from the Styles Gallery in the Home tab. Click the arrow to display more
styles. The style applied to the currently selected text will be highlighted.

File Home Insert Draw Design Layout References Mailings Review View Developer Help DocsCorp Acrobat

{T] |Arial Bold v[1o0 v AT AT Al A

. = , 1. HEADIN( 1. HEADING A1 | 1) MAIN HEADI| ~
Paste [Bl I U~ ab x, ¥ Av £+ A~

Clipboard N Font [ Paragraph [ Styles [

Not all styles are displayed in the Styles Gallery. To view a full list of styles, click the diagonal arrow in the bottom-right
corner of the Styles area to open the Styles Pane.

1. B 8 S B 20
1. HEADINC 1. HEADING A1/ 1) MAIN HEADI | ~ Ge Replace Create Dictate = Sensitivity =~ Add-ins Editor Copilot
L [y select~ a PDF v ¥
Styles Editing Adobe Acrobat Voice Sensitivity Add-ins
5.0 60 -7 0B 910 -1 1200 213 0 14
y mutual agreement may be made in writing and subject to Styles v X

LUVEL 1 TAL n

both parties.

Definition Term a

all be £1,200, payable in advance on the first day of each calendar Exhibit1 Exhibit 7

T

1 Exhibit 1 T
pid via bank transfer to the account specified by the Landlord.
1.1 Exhibit 2 T
nt shall incur interest at a rate of 2% per month on the overdue
1.1.1 Exhibit3 7
aid for more than fourteen (14) days, the Landlord may issue a 1111 ExhiT
Tenant.
1.1.1.17

Footer I#

a Security Deposit of £1,200 upon signing this Agreement.
1. HEADING /=

1. HEADING A1 b

Hyperlink a

L 1) MAIN HEADING 1 1=

Show Preview

[] Disable Linked Styles
A [A] [A] Coptors. |

Note: The Styles Pane can be moved and resized. It remains open when clicking through the document, so you may
wish to place it to the right of your document when working on formatting

Tick Show Preview in the Styles Pane to display previews of each style. Click Options... and change the Select styles to
show to filter the styles displayed. If you are working with a document containing many styles that are not used,
consider changing this to ‘In use’.
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Taming the Nightmare Document

! Style Pane Options ? X

Select styles to show:
Recommended

Recommended st
In use

In current document

It All styles

I [T] Font formatting i
I:J Bullet and numbering formatting

£ Select how built-in style names are shown i
D Show next heading when previous level is used
O Hide built-in name when alternative name exists

O Only in this document (:) New documents based on this template

TIT

OK Cancel

Applying Styles

Appplying a Style from the Styles Gallery/Pane
If text has an incorrect style applied, click on or select the text and then click the required style in the Styles Pane or

Styles Gallery.

23 Early termination by mutual agreement may be made in wrting and subject o Styles I
conditions agreed by both parties. e T
(1) Parties 1 L

1) RENT

(a} Parties 2 L

24  The monthly Rent shall be £1,200, payable in advan h calendar

month.
1. LEVEL 1 HEADIN®
25 The Rent shall be paid via bank transfer to the account specified by the Landlord,
1. LEVEL 1 NUMBEI 1
26 Late payment of Rent shall incur interest at a rate of 2% per month on the overdue

amount. 1.1 Level 2 Heading 7

Using the Format Painter
Another method to apply a style is to use the Format Painter to copy the style and formatting from one piece of text
to another. This is particularly useful if you are unsure which style you need to apply, or if you have multiple paragraphs

to reformat.
To use the format painter:

1. Select the text you want to copy the formatting from

P

2. TERM OF LEASE

2.1 The Lease shall commen
(12) months, unless termil

2. Click the Format Painter icon in the Home tab. Your cursor will change to a paintbrush
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Taming the Nightmare Document

3.

If you have multiple paragraphs to apply the selected style too, double-click on the Format Painter icon in step 2. This
will leave the format painter turned on. To turn it off, click on the icon again or press the Esc key.

File Home Insert Draw D¢

ﬂ'|1:| & |Arial Bold v||ﬁ
Paste EB

Clipboard TN Fo

sl o= SICT RSN

Click on the text you wish to apply the style to

Using ‘Select AlIl’

Take a look at this example:

Alex has a 75-page document with multiple paragraphs formatted using the style ‘MIAIN HEADING’, instead of her
house style ‘LEVEL 1 HEADING’. She is looking for a quick way to convert this text from one style to another.

To quickly convert all text formatted as one style to another:

1.

2.

Click on any paragraph in the document formatted in the incorrect style (Main Heading in the example given

above)
Right-click on the highlighted style in the Styles Gallery/Styles Pane and click Select All

| 1.1.1.1 ExhiT

Update Main Heading 1 to Match Selection

As Modify..

Select All: (No Data)

Eemove All: (No Data)

Revert to Level 1 Heading...

Remove from Style Gallery

M Showw Droview

1) MAIN HEADING 1 Elv

All the text in the document formatted with the incorrect style applied will be selected
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1) RENT

2.4 The monthly Rent shall b
month.

2.5 The Rent shall be paid vi

2.6 Late payment of Rent sf
amount.

2.7 If Rent remains unpaid 1
formal nofice to the Tenz

2) SECURITY DEPOSIT
2.8 The Tenant shall pay a §

29 New text

3. Click on the correct style in the Styles Pane/Styles Gallery (Level 1 Heading in the example given). It will be
applied to the selected text

{a) Parties 2 ¥

2.3 Early termination by mutual agreement may be made in writing and subject o
conditions agreed by both parties. 1. LEVEL 1 HEADIN
1] RENT 1. LEVEL 1 NUMBE!*

24 The monthly Rent shall be £1,200, payable in advance on the first day of each calendar

1.1 Level 2 Heading "
manth.

1.1 Level 2 Number ¥
25 The Rent shall be paid via bank transfer to the account specified by the Landiord.

T
28 Late paymenl of Rent shall incur interest at a rate of 2% per month on the overdue 1LY Lavara s

SHIRE 1.1.1 Level 3 Mure
27 If Rent remains unpaid for more than fourteen (14) days, the Landlord may issue a Lever

farmal notice to the Terant. 1.1.1.1 Leve
2) SECURITY DEPOSIT 1.1.1.1 Lewer
2.8  The Tenant shall pay a Security Deposit of £1,200 upen signing this Agreement. 1.1.1.17

Show Preview

v B ot

Clearing Formatting

If the correct style has been applied to the text but there are still issues with the formatting or numbering, you can try
clearing the formatting and then reapplying the style.

To remove the formatting from the selected text, click the Clear All Formatting icon in the Home tab.

Home Insert Draw Design Layout References  Mailings

| Calibri oA A Aa~

—T

IE
3 B I U~a x, X A~ £+ A
\'5 Format Painter

Clipboard Il Font Il

To remove the formatting from all text of a particular style, right-click on the style in the Styles Gallery/Styles Pane
and select Remove All.
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[ 1.1.1.1 Exhi T
Update Main Heading 1 to Match Selection

As Modify..

Select All: (No Data)

l Remove All: (No Data) l

Revert to Level 1 Heading...

Remove from Style Gallery

1) MAIN HEADING 1 ﬁl v

Shrnsr Drewisiar

All numbering and formatting will be stripped from the text.

conaitions agreed
2 RENT

24 The monthly Rent
month.

25 The Rent ehall he

Click on the required style to apply it.

Modifying a Style
If you are still experiencing issues with formatting within the document, particularly if the issues are occurring every
time you apply a style, check the style settings and modify them if needed.

To modify a style, right-click on it from the Styles Gallery or Styles Pane and select Modify...

(a) Parties 2 T

1. LEVEL 1 HEADINZ

w

(-

Update Level 1 Heading to Match Selection

As Moadify..

Select All 5 Instance(s)
Clear Formatting of 5 Instance(s)

Delete Level 1 Heading...

Remove from Style Gallery

This will display the Modify Style dialog box. Basic formatting can be changed here, for example the font size and
colour.
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Taming the Nightmare Document

Modify Style ? X
Properties

Name: Level 1 Heading

Style type Linked (paragraph and character)

Style based om: 9 Normal

Style for following paragraph: = ¥ Level 2 Number

Formatting
Arial Bold s vllBl r u |l Automatic  ~
= = = = = = = A= Y= - =
e — e ] = = = = r= &= o=
1. RENT

Font: Arial Bold, Bold, All caps, Indent:
Left: 0 cm
Hanging: 1.27 cm, Space
Before: 6 pt, Keep with next, Level 1

Add to the Styles gallery [ Automatically update
° Only in this document (O New documents based on this template

Format ~ OK Cancel

For additional settings, such as paragraph formatting, click Format and then select an option.

1. RENT
Font...
Paragraph...
Tabs...

Border...

Language... :aps, Indent:
Frame... e

Numbering... next, Level 1

Shortcut key.. (] Automatically updat

Text Effects... _) New documents baseq

Note: If you are experiencing issues with numbering, follow the steps in the section ‘Multi Level Numbering’ within this

guide

Click OK to apply the changes and close the dialog box. All text that is formatted with the style will now be updated
with the changes made.
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Taming the Nightmare Document

Multi Numbered List Styles

If there are issues with numbering within a document, the first step is to check the style applied to the text. Acommon
issue is that the style used is incorrect and when the correct style is applied, the numbering automatically corrects
itself.

If there are still issues with numbering in the document once the correct style has been applied, it may be due to the
settings of the multi-level list.

Viewing and Modifying a Multi-Level Numbered List
To access the settings of a multi-level list style:

1. Click on any numbered item in your document
2. Click the arrow to the right of the Multi-Level List icon on the Home tab
3. Right-click on the highlighted style and select Modify

== =L
I Y A | 1- HEADING AT 1) MAIN H
Currdnt List 2
b Styles
; i Yl R T TR TR
11 Levs et and other services supplig
11.1Le
Z
21 List Libra V2026 and shall continue for
y in accordance with this Agrg
2.2 3 the Lease by providing w
MNeng 1L 5 the expiry of the Term,
1114
23 ent may be made In writl
] [ Adticle | 1Heading 1
3. — Section 181 11 Hes
(&) Heading 111
2 31 able in advance on the firstd
| = g1 Chapter 1Haa
82| | AHeading. | | Headng2 er to the account specified b
1. Hzadin Hea
3.3 rest at a rate of 2% per mor
List Styles
3.4 fourteen (14) days, the Larn
Appendix 1Az | | Exchibit TEie | | 1.417 1
1) 1 Sppendm 1 Exhibt 1 1.1
11Appenax: T e i Add Gallery to Quick Access Toolbar
35 T ETUT C L EUT UROTT SIgTITg il
1) Mai
b s -

4. In the Modify Style dialog box, click Format and select Numbering
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Meodify Style
Properties
Name:
Style type
Formatting
Start at:

Apply formatting to:

Eont..

Shortcut key..

Text Effects

——

1,23, ..

List Levels

Lict
L

1 -

1st level

B I U

ne numbered = Level 1 = Numbering Style: 1, 2, 3, ... + Startat: 1 =
at: 0 cm + Tab after 1.27 cm + Indent at: 1.27 cm, Priority: 100
;'= New documents based on this template

oK Cancel

The Modify Multilevel list will be displayed. Click More in the bottom-left corner to display all options (shown below).

Madify Multilevel list
Select the |-
level to iic_kﬁ_gelto modify:
mOdlfy ;- 1. Level 1 Heading
3
4 1.1 Level 2 Number
5 1.1.1 Level 3 Number
6 1.1.1.1 Level 4 Number
Edit the text |{—; 1.1.1.1.1 Level 5 Number
di 9 1.1.1.1.1.1 Level & Number
surrounding 11144011
the number' 1.4.44.11.%4
dot R G e
e.g. dots or
bracket Nymber format
rackets Jnterfgrrnatting for number:
|1. Font...
Number style for this level: Inciude level number from:
1,23 .
Selectthe || _
number Position
format for Number alignment: || .5 Aligned at: g cm D
this level Text indent at: 1.27 cm = Set for All Levels...
eg.123or
abc

? X
Apply change
hole list
Link level to style:
Level 1 Heading
Level to show in gallery:

ListNum field list name:

Start at:

1

Reatart list after

[] Legal style numbering

Follow number with:
Tab character
8 2dd tab stop at:

-

1.27 cm -

oK Cancel

Select a style to
associate with
this level

Add numbers
from previous
levels

same for each level

Alignments and indents. Choose 'Set for All
Levels..." if the additional indent will be the

Click OK to save any changes.
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Table of Contents

Common issues with tables of contents (TOC) include text mistakenly included/excluded, or formatting issues.

Again, the first step for checking any issues is to ensure the correct styles are used throughout the document. Often
only first level are included in a TOC. If text is incorrectly included/excluded, check that it has the correct style applied.

If you are still experiencing issues and the styles are correct, consider amending the TOC settings.

Changing Table of Contents Settings

To edit the settings of a TOC, click Table of Contents in the References tab and select Custom Table of Contents.

File Home Insert Draw Design Layout References
@ Add Text v a b' H_T‘J Insert Endnote [
| R -
Tabls ot E] Update Table s an Next Footnote |
Contents Footnote [ Cita
Built-In
Automatic Table 1
Contents
Heading 1 1
Heading 2 1
Heading 3 1
Automatic Table 2
Table of Contents
Heading 1 1
Heading 2 1
Heading 3 1
Manual Table
Table of Contents
Type chapter title (level 1), 1
Type chapter title (level 2) L2
Type chapter title (level 3) 3
Type chapter title (level 1) 4
Type chapter title (level 2) 5
@ More Tables of Contents from Office.com >
[ Custom Table of Contents... ]
[-_?2 Remaove Table of Contents

The basic TOC settings are shown here, including the Tab leader (the special character between the heading text and

the page number). Ensure the Show levels setting is correct — for example, if this is set to 1, only the first level headings
in your document will be included in the TOC.
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Table of Contents ? X
Index of Figures Table of Authorities
Print Preview Web Preview
Heading 1. | Heading 1
Heading A .. SNV Heading A
Heading A1...... B Heading A1
Level 1Heading ... .1 Level 1 Heading
@ show page numbers 8 Use hyperlinks instead of page numbers
B Right align page numbers
Tab feader:
General
Formats: From template
Show levels: |3 3
Options... Modify
Ok |  Cancel
Options

Click Options... in the TOC dialog box to display a list of style and their corresponding TOC level. In the example below,
the style Level 1 Heading is set to TOC level 1. Ensure any styles that should be included have a TOC level assigned (by
typing a number into the corresponding TOC level box). Remove the numbers from any styles that should not be
included.

Table of Contents Options ? X

Build table of contents from:
Styles

Available styles: TOC level:
HTML Address
HTML Preformatted
Index Heading
Intro Heading

v Level 1 Heading 1
Level 1 Number

Outline levels
(] Table entry fields

Reset [ oK Cancel

Click OK to save any changes.

Modify
Click Modify... in the Table of Contents dialog box to amend the formatting of the different TOC levels, for example to
make text bold or change the alignment. Select a TOC level and then click Modify... to display formatting options.
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Style ? X

Please select the appropriate style for your index or table
entry

Styles:
TOC1 New.,

R
T T10C2 Delete
T 10C3
T 10C4
T TOCS
¥ 10CHE
T T1OCT
T TOCS
| ¥10C9 v

Preview

Arial e

Da not check spelling or grammar, Indent:
Left: 0 em |

Hanging: 1.27 cm, Space
Before: 6 pt

OK Cancel |

Change font options here, or click Format to amend other options such as paragraph formatting.

Muodify Style ? X
Properties
Name: TOC1
Style type: . Paragraph w
Style based on: T Normal

Style for following paragraph: | T Normal

Formatting
Arial vifiiv|| B I U Automatic v

I
il
Il|
Il
IIf
1l
“ 35
Il 1hi
-
il
hd

The Lease shall commence on 21/01/2028 and shall continue for a period of twehe (12)
months, unless terminated earber in accordance with this Agreemeant.

Do not check spelling or grammar, Indent:
Left: O cm
Hanging: 1.27 cm, Space
Before: 6 pt
(] Add to the Styles gallery [ Automatically update

[ o] Only in this document (_) New documents based on this template

Format ~ l OK Cancel

Click OK and then OK to save.
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Cross References

References to clauses/numbered items within a document should always be created using the cross-referencing tool
within Word. Manually typed references are not accurate and take time to update when a document changes.

Creating a Cross Reference

To create a cross reference:

1. Click at the location that you wish to insert the cross-reference

ibitable condition; otherwise, cleaning
ty Deposit (see clause |

2. Click on the References tab and click the Cross-reference button

References Mailings Review View Developer Help DocsCorp Acrobat
ote o E Manage Sources —_— Insert Table of Figures —|
= bl [
ote ¥ Insert rp Style: |M| Change Insert D M
Citation ¥ [T] Bibliography v Provider ~ CEDTiOTI [ Cross-reference l E
[ Citations & Bibliography Captions

3. This will display the Cross-reference dialog box. Ensure the Reference type dropdown is set to Numbered
item and the Insert reference to dropdown is set to Paragraph number
4. Select the clause you wish to reference

Cross-reference O X
Reference type: Insert reference to:

Numbered item ~ | Paragraph number
B insert as link [ Include above/below

Separate numbers with

For which numbered item:

(1) JOHN SMITH, of 123 Main Street_London, England ('the Landlord}: and |
(2) JANE DOE, of 456 Oak Road, London, England (‘the Tenant’).
| 1. INTERPRETATION
1.1 In this Agreement:
| 2. TERM OF LEASE
2,1 The Lease shall commence on 21/01/2026 and shall continue for a peri...
2.2 The Tenant may request renewal of the Lease by providing written not..
| 2.3 Early termination by mutual agreement may be made in writing and su..
3. RENT
3.1 The monthly Rent shall be £1,200, payable in advance on the first day ...
3.2 The Rent shall be paid via bank transfer to the account specified by th..
| 3.3 Late payment of Rent shall incur interest at a rate of 2% per month on...

Insert

Cancel

5. Click Insert, then close the dialog box

Clicking on a cross-reference displays shading, indicating that it is a field. Holding CTRL and clicking the cross-
reference will navigate you to the referenced paragraph.

ttion from the Security Deposit

Current Document
ble condition; otherwiCtrl+Click to follow link
eposit (see clause 5.2
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Updating Cross References
Cross references do not update automatically when a document changes. To update a cross-reference, right-click on

it and select Update Field.

CUTTUTIIUTT, UTTTETWIST, LITATTITTY
psit (see clause 5.

‘ Search the menus

writing and deliv| [y
ﬁ“] Paste Options:
7 &

ithin seven (7) day [B| Update Field

y if confirmation ¢

standing between Edit Field..

resentations. .
Toagle Field Codes

To update all cross references in a document at the same time, including the table of contents, use the keyboard

shortcut CTRL + A and then F9.
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